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1 Welcome 

The Telescience Resource Kit (TReK) is a suite of software applications and libraries that 

can be used to monitor and control assets in space or on the ground.  The TReK Metadata 

application provides the capability to create and manage telemetry and command 

metadata. This includes support for creating databases and metadata files and translating 

between different types of metadata formats.  

 

This tutorial provides step-by-step instructions describing how to perform common 

application functions.   

 

The topics in this tutorial require an understanding of the topics covered in the TReK 

Concepts document.  Please be sure you have read the TReK Concepts document before 

proceeding with this tutorial. 

 

This tutorial uses screen dumps taken on a Windows computer.  However, the steps are 

the same regardless of whether you are running on Windows or Linux.   

 

 

2 Technical Support 

If you are having trouble installing the TReK software or using any of the TReK 

software, please contact us for technical assistance: 

 

E-Mail:            trek.help@nasa.gov 

 

Messages sent to this address are automatically forwarded to the TReK team. 

 

The HOSC Help Desk (256-544-5066) can provide assistance as needed and is available 

24x7. 

 

3 Introduction 

The TReK Metadata application provides the capability to create and manage telemetry 

and command metadata. This includes support for creating databases and metadata files 

and translating between different types of metadata formats.   For a more detailed 

introduction to TReK metadata please reference the TReK Concepts document. 

 

Packets are most often the data that are sent from one system to another system.  

Commands and telemetry are just packets.  Command data is packets that tell another 

system to do something.  Telemetry data is packets that supply information about the 

system sending the packet. 

 

Parameters are the individual data values that contain information about the state of the 

sending system or actions to be taken by the receiving system.  Parameters have a value 

and are either placed in the outgoing data or pulled from the incoming data.  TReK uses 
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the terms “build” to describe placing parameters in a packet and “extract” to describe 

pulling parameters from a packet. 

 

Parameters are grouped with related parameters into collections named parameter 

collections.  Parameter collections are the basic building blocks of packets which are the 

data sent from one system to another.  Figure 1 has four views of the same packet.  The 

first row shows a packet as a single entity that could be sent between systems.  The 

second row shows that the packet is composed of parameter collections and another 

packet.  The third row shows that eventually a packet will break down into a series of 

parameter collections.  The final row shows that all parameter collections are a series of 

parameters.  Each row is a different view of the same data. 

 

Packet

Parameter Collection

A B C D FE G J KIH L N OM

Parameter 

Collection
Packet

Parameter Collection
Parameter 

Collection

Parameter 

Collection
Parameter Collection

 

 Figure 1 Packets, Parameter Collections, and Parameters 

  

As mentioned earlier, Packets are the data that travel between systems.  The packet is the 

largest aggregation of data in TReK. 

 

Packets are divided into three zones:  header, data, and trailer.  One or more zones must 

be defined in a packet for it to be considered valid.  Figure 2 shows each of the three 

zones and their relative locations.  Each zone of a packet contains either another packet or 

a parameter collection. 

 

DataHeader Trailer

DataHeader
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Figure 2 A Packet and Its Zones 

 

The first line in the figure above shows a packet that has all three zones defined.  The 

second level shows that the header and trailer zone are composed of parameter 

collections which contain one or more parameters.  The data zone is composed of another 

packet which only has the header and data zones defined.  The third line shows that the 

packet in the data zone of the top-level packet is composed of two parameter collections 

and that all the data in a packet will eventually break down into a series of parameters. 

 

The Metadata application provides the capability to create and modify a telemetry packet 

or a command packet.   The application provides all the support needed to define the 
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details for a Packet, Parameter Collection, and Parameters like those shown in Figure 1 

and Figure 2.  Once defined these packet definitions can then be used with various TReK 

applications to monitor and control an asset in space or on the ground.   

 

Since there are many ways to format metadata, TReK supports a variety of formats as 

described below.   

 

C Programming Language Header File 

Many software developers represent a packet definition using a C structure defined in a C 

header file.  TReK can import the packet definition by reading the C structure defined in 

a C header file.   

 

Common Data Exchange Format (CDEF) 

CDEF is an International Space Station (ISS) program format that contains metadata 

described using XML.  It is used to exchange telemetry and command information 

between data systems. 

 

TReK Database 

A TReK database is a SQLite database that can contain metadata information for one or 

more packets. 

 

TReK Metadata File 

This is a TReK generated file that contains metadata described using XML (e.g., a Packet 

definition, a Parameter Collection definition). 

 

The Metadata application can read, write, and translate between these different types of 

formats. 

 

The Metadata application also provides the capability to import metadata information 

obtained from the HOSC including metadata defined in Partial Database Download Files 

and Ground Support Equipment (GSE) packet definitions. 

4 Overview of the User Interface 

4.1 Main Window 

The main window contains several areas as shown in Figure 3.  The Toolbar contains 

multiple buttons that reconfigure the main window to focus on a specific metadata 

element such as a Parameter Collection, a Database, a Limit Alarm, a Packet, etc.   
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Figure 3 Main Window 

Toolbar 

The toolbar at the top of the window provides quick access to configure the main window 

to work on a specific metadata element.  

 

Library Area 

The Library Area is context sensitive and will be reconfigured to support the specific area 

you are working on.  For example, if you are creating a Parameter Collection, the Library 

Area will be configured to show a list of all the types of parameters that you can add to a 

parameter collection.  If you are working on a Database, the Library will be configured to 

show you a list of databases you can work with. 

 

Work Area 

The Work Area is context sensitive and will be reconfigured to support the specific type 

of element you are working on.  If you are working on a Parameter Collection, the Work 

Area will display the Parameter Collection content.  If you are working on a Database, 

the Work Area will display the list of packets in the Database you have selected.  If you 

are working on a Limit Alarm, the Work Area will display the content of the Limit 

Alarm.  If you are working on a Packet, the Work Area will display the contents of the 

packet.  The Work Area provides the capability to create or modify the contents of a 

specific element.   

 

Button Area 

The Button Area is context sensitive and will be reconfigured to display functions 

available for the specific area you are working on.  For example, for a Parameter 

Collection, you would have functions such as creating a New Parameter Collection, 

Validating a Parameter Collection, and Exporting the Parameter Collection (saving it in a 

file in a specified format).  There are also functions available to modify the order of 
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parameters in the collection by moving them up and down in the list and deleting a 

parameter. 

 

Message Area 

The Message Area displays important status and error messages.  The message area can 

be cleared using the View menu.   The Message Area is a dock window that you can float 

or dock.  To float a dock window, use your left mouse button to click and hold the title 

area while dragging the window to another area of the screen.  To dock, use the title bar 

to drag the dock window over the main window and drop. 

4.2 Menus 

The Metadata application menus are File, Edit, View, Options, and Help.  Each of these 

menus is described in more detail below. 

 

File Menu 

The File menu provides the capability to manage configurations and exit the application. 

 

Edit Menu 

Provides an alternative means to configure the main window to work on specific 

metadata elements.  This is especially useful if you reconfigure the application to hide the 

Toolbar. 

 

View Menu 

The View menu provides the capability to clear the main window message area and show 

and hide different areas in the main window.   

 

Options Menu 

The Options menu provides access to the Messages dialog and other special functions 

such as working with HOSC Partial Database Download files, Common Data Exchange 

Format files, and Gateway XTCE files. 

 

Help Menu 

The Help menu provides access to on-line help and application version information. 

 

 

5 TReK Metadata Tour 

Sometimes it’s easier to learn how to use an application by example.  This section 

describes how to use the Metadata application to create a Telemetry Packet definition and 

then use it with the TReK Data application to receive and process telemetry data that 

matches that packet definition.  Figure 4 shows the structure of the Telemetry Packet to 

be defined. 
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Figure 4 Tutorial Telemetry Packet 

 

This packet contains a Header Zone and a Data Zone.  Each zone contains a parameter 

collection.  The final product will be a packet with a CCSDS Header in the Header Zone 

and a Custom Parameter Collection in the Data Zone.  Most programs select a standard 

header (e.g., CCSDS) or define a custom header that will be used on packets exchanged 

between their flight and ground systems.  It is common to create multiple packets that all 

have the same header zone but contain different data zones.     

 

Step-by-Step instructions are divided into the following sections: 

 

❖ Create a Parameter Collection – this section shows how to create a custom parameter 

collection that will serve as the Data Zone of the Packet 

 

❖ Create a Packet – this section shows how to use a packet template to create a 

telemetry packet and then add the custom Parameter Collection to the Data Zone. 

 

❖ Packet Data Flow – this section shows how you can use the packet definition you 

created with the TReK Data application to receive and process packets that match the 

packet definition. 

 

This section was written assuming you have read the Introduction and Main Window 

sections.  If you have not read these sections, please read them.  They contain important 

information that is not repeated in this section.   

 

If at any time you need to exit the application so you can resume working through the 

Tutorial later, File Save will allow you to save all the data you entered. 

 

Please go through the tour in order.  Some sections depend on data from previous 

sections. 
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Create a Parameter Collection 
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5.1 Create a Parameter Collection 

The first step in creating the Telemetry Packet definition is to create a Parameter 

Collection to serve as the Data Zone.  The following steps describe how to create a 

Parameter Collection.  Let’s look once again at the packet you are going to define.  It is 

shown in Figure 5 below.   

 

Packet

Header Zone

CCSDS Header

Parameter Collection

Data Zone

Parameter Collection

Data
 

Figure 5 Tutorial Telemetry Packet 

 

The Parameter Collection in the Data Zone will contain the following parameters as 

shown in Table 1 below. 

 

Parameter Start Bit Data Type Total Length 

UINT_16 0 Unsigned Integer 16 (2) 

INT_32 16 Sign and Magnitude Integer 32 (4) 

FEEE_64 48 Floating Point 64 (8) 

SUND_80 112 Undefined String 80 (10) 

Table 1 Data Zone Parameters 

 

Step-By-Step 

 

1. If you haven’t started the Metadata Application, use the operating system’s menu to 

start the application.  You should see the Metadata main window shown in Figure 6. 

 

The Main Window initializes with the Collection work area as the default.  On the 

left-hand side of the Main Window you will see the Library Area.  It is configured to 

provide access to items you can use to create a Parameter Collection.  In the middle 

of the Main Window you will see the Work Area showing the Parameter Collection 

Tab.  This is where you will define the details of your Parameter Collection.  On the 

right-hand side of the Main Window you will see a list of buttons that provide various 

capabilities applicable to the Parameter Collection you are working on (e.g. 

Validating the Parameter Collection and Exporting the Parameter Collection).   
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Figure 6 Metadata Main Window 

 

2. Start by entering a name for the Parameter Collection.  In the Name field enter 

Science Data.  After completing this step, the Main Window should look like the one 

shown in Figure 7. 

 

 

Figure 7 Parameter Collection Name - Science Data 

 

3. Since you are creating a Telemetry Collection you need to ensure the Telemetry radio 

button is selected as shown in Figure 7. 

 

4. The next step is to start adding parameters to the Parameter Collection.  There are 

four parameters you need to add to the Parameter Collection.  The Metadata 

application uses Drag and Drop to move items from the Library Area into the Work 
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Area.  The first parameter you need to add to the Parameter Collection is a 16-bit 

unsigned integer.  Go to the Library Area and click on the Integer item in the list so it 

expands as shown in Figure 8. 

 

 

 

Figure 8 Library Area Showing Integer Expanded 

 

5. Use your left mouse button to select the Unsigned Integer 16-bit item in the list, 

and while holding the left mouse button down, drag the item to the Work Area 

and drop it as shown by the arrows in Figure 9.  After dropping, you should see 

the parameter in the list as shown in Figure 10. 

 

 

Collection Drag and Drop Tips and Tricks 

 

❖ If you drop an item anywhere on the list, it will be placed at the end of the list. 

❖ If you drop an item on top of another item, the item will be placed below that 

item in the list. 
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Figure 9  Drag and Drop Areas for 16-Bit Unsigned Integer Parameter 

 

 

 

 

Figure 10 16-Bit Unsigned Integer Parameter in List 

 

 

6. Now you need to fill in the information for the Parameter.  Use your left mouse 

button to double click in the Name cell of the row in the list and then enter the 

name UINT_16.  When you are finished it should look like Figure 11. 
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Figure 11 UINT_16 Parameter Updated with Name 

 

Note:  If the columns are not wide enough to display the text in the column, you can 

resize the columns by dragging the vertical bar next to the column name. 

 

7. The next item to fill in is the Start Bit.  Since this is the first parameter in the 

Parameter Collection, enter 0 for the Start Bit as shown in Figure 12. 

 

 

 

Figure 12 Start Bit of 0 
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You have now completed entering the first parameter in the Parameter Collection.  

Now you need to perform the same steps for each of the remaining three parameters.   

 

8. Notice that the Data Type, Data Format, and Length columns are already filled in 

for you.  This is because you selected a specific parameter type from the Library 

that had a predefined length.  A telemetry parameter is always considered 

modifiable.  Since you are defining a telemetry packet, there is no need to specify 

a value.  It will be extracted from the telemetry packet.    

 

9. The second parameter in the list is a 32-bit Sign and Magnitude Integer.  Find the 

Sign and Magnitude Integer in the Library and drag and drop it into the list.  

Depending on where you drop it in the list the item may end up as the first item in 

the list instead of the second item in the list.  No worries.  Just select the 32-bit 

Sign and Magnitude Integer in the list and push the Move Down button to move it 

to the second position in the list.  The Main Window should look like the one in 

Figure 13. 

 

 

 

Figure 13 Sign and Magnitude Integer 

 

10. As before, edit the row to enter the name (INT_32), the Start Bit (16), and the 

Length (32).  Once you are done your list should look like the one in Figure 14. 
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Figure 14 Sign and Magnitude Parameter 

 

11. The third parameter in the list is a 64-bit Floating-Point parameter.  Expand the 

Floating-Point item and look for 64-bit IEEE Floating Point item.  Drag and drop the 

item in the list and edit the row to enter the name (FEEE_64) and the start bit (48).  

The Main Window should look like the one in Figure 15. 

 

 

Figure 15 IEEE Floating Point Parameter 
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12. The fourth parameter in the list is an undefined string that is 80 bits (10 bytes) long.  

Find the Unspecified Bytes parameter and drag and drop it in the list.  Edit the row to 

enter the name (SUND_80), the start bit (112), and the length (80).  The Main 

Window should look like the one in Figure 16. 

 

 

Figure 16 Undefined String Parameter 

 

 

13. In order to use the new Parameter Collection in a packet, you need to export the 

Parameter Collection so it is saved in a file.  Before you export, it is always a 

good idea to validate to be sure everything is correct.  Push the Validate button.  

You should see a dialog like the one shown in Figure 17. 

 

 

 

Figure 17 Validate Collection Dialog 

 

Note:  If there are errors, please check your entries to be sure they match the 

information in the tutorial. 

 

14. Now that you know the collection is valid, push the Export button to export the 

Parameter Collection.  You should see the dialog shown in Figure 18.  Notice that 
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the Filename defaults to the collection name and the default location is the 

telemetry_collection directory in the trek_workspace. 

 

 

 

Figure 18 Export Telemetry Collection Dialog 

 

 

15. In the Export Collection dialog, push the OK button to perform the Export.  You 

should see the message in Figure 19.  Push the OK button in the message dialog 

and both the message dialog and the Export dialog will close.  Once the Export 

dialog closes a message will appear in the Main Window message area and the 

Science Data collection will be listed in the Telemetry Collection list in the 

Library Area.   

 

 

Figure 19 Export Successful Message 

 

 

Congratulations – you have successfully created your first Parameter Collection.   
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Create a Packet 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

5.2 Create a Packet 

This section will cover how to create a packet.  If you haven’t moved to the Packet tab 

yet, please push the Packet button in the Main Window toolbar so your Main Window 

looks like the one in Figure 20.    
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Figure 20 Main Window with Packet Selected 

 

As shown in Figure 21, the goal of this tutorial is to create a CCSDS packet.  A CCSDS 

Packet has a CCSDS Header and a specific set of Packet Attributes.  You could create the 

packet from scratch.  However, it is much easier to use a packet template and save 

yourself some work.  TReK provides a set of predefined packet templates.  These are 

listed under “telemetry_packet_template_from_install” and 

“command_packet_template_from_install”.  A packet template is a packet that includes 

pre-populated zones and packet attributes corresponding to the specific type of packet.  

For example, a CCSDS packet template contains a CCSDS Header and the following 

packet attributes:  a Counter parameter, an APID Identifier, a Length parameter, and a 

Timestamp Parameter.  By using a template, you can start your packet definition with all 

that information already defined. 

 

CCSDS Header Data
 

Figure 21 CCSDS Packet 

 

The Main Window Library Area is configured to provide access to items you can use to 

create a packet.  In the middle of the Main Window, the Packet tab provides a place to 

define the details of your packet.  On the right-hand side of the Main Window the buttons 

provide various capabilities applicable to the Packet you are working on.  

 

Notice the rectangle that contains three smaller rectangles with one for each zone of the 

Packet (Header, Data, and Trailer) as shown in Figure 22.   
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Figure 22 Packet Drop Zones 

 

These rectangles are “Drop” zones.  The large rectangle is a drop zone for the Entire 

Packet.  If you drop a Packet Template or a Packet on the large rectangle, this will 

populate the entire Packet.  If you drop a Packet or a Parameter Collection on one of the 

individual packet zones, that zone of the Packet will be updated.  The drop zones will 

highlight so you can verify you are dropping the item in the correct location.  Figure 23 

shows what the “Entire Packet” drop zone looks like when it is highlighted.  Figure 24 

shows what the “Data Zone” drop zone looks like when it is highlighted. 

 

 

Figure 23 Entire Packet Drop Zone Highlighted 

 

 

Figure 24 Data Zone Drop Zone Highlighted 

 

 

16. To get started, first enter Science Packet in the Name field as shown in Figure 

25. 

 

 

 

Figure 25 Packet Tab with Name Populated 

 

17. Since the packet is a Telemetry Packet, ensure the Type is set to Telemetry as 

shown in Figure 25. 
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18. In the Library Area, ensure the “telemetry_packet_template_from_install” item is 

expanded to show the list of templates as shown Figure 26.  Your list may vary 

based on the release version of TReK. 

 

 

Figure 26 Telemetry Predefined Packet Template List Expanded 

 

19. In the Library Area, you may see several “CCSDS” related packet templates.  

Some projects use a standard header.  For this tutorial, we will use a sample 

CCSDS Header.  Select the trek_ccsds_template item under the 

“telemetry_packet_template_from_install” list using your left mouse button.  

Hold the left mouse button down and drag the item into the large rectangle – you 

should see it highlight the entire packet drop zone as shown in Figure 27.  You 

must avoid dropping on the specific zone names.  Once you see the highlight 

release the mouse button to drop the item.  Once you drop the item your Main 

Window should look like the one in Figure 28.  You can now see you have a 

packet with a CCSDS Header.  Dropping in this specific area sets the template of 

the packet and auto-configures the properties of the packet. 

 

Note:  If by chance it did not drop into the location you intended, you can push 

the New or Clear button to clear the packet and start over. 
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Figure 27 Entire Packet Drop Zone Highlighted 

 

 

 

Figure 28 trek_ccsds_template Packet 

 

 

20. To see that the Packet Attributes are already defined by the Packet template, push 

the Properties button to display the Packet Properties dialog as shown in Figure 

29.  If you look through the tabs in the dialog, you will see it has a Counter 

parameter, an APID identifier, a Length parameter, and a Timestamp parameter.  

Go to the Identifiers tab and set Has Expected Value to true and Expected 

Value to 314 as shown in Figure 30.  Identifiers are used to identify incoming 
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data so the expected value of 314 must be entered for the APID.  Push the OK 

button to close the Packet Properties dialog and save this change. 

 

 

Figure 29 Packet Properties Dialog 

 

 

Figure 30 Packet Properties Dialog (Identifiers Tab) 

 

20. Now it’s time to add the Science Data collection you created in the Data Zone of 

the packet.  In the Library Area, be sure the Telemetry Collection item is 

expanded so you can see the list as shown in Figure 31. 
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Figure 31 Telemetry Collection List Expanded 

 

21. In the Library Area, select the Science Data item and drag and drop it over the 

“Data” Drop Zone.  Remember to look for the Data rectangle to highlight so you 

know that you are dropping it in the right location.  Your Main Window should 

look like the one in Figure 32. 

 

 

Figure 32 Science Data Collection in Data Zone 

 

 

22. There is one more step to finish the packet definition.  Since this is a unique 

packet definition, you will set the CCSDS Application Identifier (APID) to give 
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the packet a unique number.  The APID parameter is the fourth parameter in the 

list of parameters in the Header.  Double click in the Value cell of the APID row 

and enter the number 314.  Your Main Window should look like the one shown in 

Figure 33. 

 

 

Figure 33 Packet with APID Value Set to 314 

 

 

23. As before, it is always a good idea to Validate your packet definition.  Push the 

Validate button and you should see the Validate dialog as shown in Figure 34. 

 

 

Figure 34 Packet Validate Dialog 

 

24. Now that you know the packet is valid, push the Export button to export the 

Packet.  You should see the dialog shown in shown in Figure 35.  Notice that the 

filename defaults to the packet name and the directory defaults to the 

telemetry_packet directory in the trek_workspace. 
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Figure 35 Export Telemetry Packet Dialog 

 

. 

 

25. In the Export Packet dialog, push the OK button to perform the Export.  You 

should see the Export Results message dialog showing the export was successful.  

Push the OK button to close the Export Results message and the Export dialog.  

Once the Export dialog closes you should see a message in the Main Window 

indicating the export was successful and the Science Packet will be listed in the 

Telemetry Packet list in the Library Area.   

 

 

Congratulations – you have successfully created your first Packet! 

 

You have completed all the tasks you need to perform with the Metadata Application so 

you can exit the application.  You don’t need to save the configuration since you have 

exported all changes to the disk. 
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5.3 Packet Data Flow 

This section will show you how you can use the packet definition you created with the 

TReK Data application to receive and process Packet 314 data.   

 

26. Go to the operating system’s menu to start the TReK Data application.  You should 

see the TReK Data main window shown in Figure 36. 

 

 

 

Figure 36 TReK Data Main Window 

 

 

27. Go to the Service menu and select Add Service.  You should see the dialog 

shown in Figure 37. 
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Figure 37 Add Service Dialog 

 

 

28. In the Add Service dialog enter Packet 314 in the Service Name field as shown 

in Figure 38.  Enter the loopback address (127.0.0.1) in the Local IP Address 

field.  All the other settings on this tab are set correctly. 
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Figure 38 Service Name Populated 

 

 

29.  Go to the Data Description tab as shown in Figure 39.  The Filter should be set to 

Packet List.  Use the Packet Type menu to select TrekCcsds.   
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Figure 39 Add Service Dialog Data Description Tab 

 

30. On the Data Description tab push the Browse Disk button.  In the Open dialog 

that is displayed select the Science Packet.xml file and push Open.  This will add 

the packet to the packet list and your dialog should look like the one in Figure 40. 
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Figure 40 Science Packet in Packet List 

 

 

31. Select the Process tab as shown in Figure 41. 
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Figure 41 Process Tab 

 

 

32. In the Process tab, select the Yes radio button to indicate you want to process data 

when it arrives as shown in Figure 42. 
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Figure 42 Process Tab with Process set to Yes 

 

 

 

33. Push the OK button in the Add Service dialog to close the dialog. 

 

34. Select Packet 314 in the Main Window as shown in Figure 43. 
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Figure 43 Packet 314 in the Data Main Window 

 

 

35. With Packet 314 selected, go to the Service menu and select Activate Service.  

Your Main Window should look like the one shown in Figure 44.  Now you have 

everything configured to receive and process your packet. 
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Figure 44 Packet 314 Activated 

 

 

36. In the Parameter menu, select Manage Displays.  You should see the dialog 

shown in Figure 45.   

 

 

Figure 45 Displays Dialog 
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37. In the Displays dialog, select the TrekCcsds.314 display and push the Start 

button.  You should see the dialog shown in Figure 46.  Now you have a display 

to see the processed data each time a packet is received. The Value and Status 

columns are empty because you have not received any data. 

 

 

Figure 46 Science Packet Display 

 

38. Now we need to flow some data.  Go to the operating system’s menu to start the 

TReK Generator application.  You should see the Generator Main Window 

shown in Figure 47. 
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Figure 47 Generator Main Window 

 

39. In the Generator application, go to the Service menu and select Add Service.  

You should see the dialog shown in Figure 48. 
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Figure 48 Generator Add Service Dialog 

 

40. In the Add Service dialog enter Packet 314 in the Service Name field. 

 

41. On the Generate Tab select the Browse Disk button.  In the Open dialog that is 

displayed choose the Science Packet.xml metadata file and push the OK button 

to add it to the list.  The Generator application will use information in the 

metadata file to automatically generate data values for the packet contents.  Your 

dialog should look similar to the one shown in Figure 49. 
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Figure 49 Add Service Dialog Generate Tab (Packet 314) 

 

42. Select the packet in the list and push the Configure button.  You should see the 

dialog in Figure 50. 

 

 

Figure 50 Configure Generator Properties Dialog 

 

43. In the Configure Generator Properties dialog change the duration to 100 and then 

push the OK button.  You should see the duration has been set to 100 in the Add 

Service dialog as shown in Figure 51. 
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Figure 51 Add Service Dialog Generate Tab 

 

44. Go to the Forward Tab.  In the Destination List Network Tab push the Add 

button to add a row to the table.  Enter the following information in the row to 

define a destination with details on where and how to forward the generated data: 

 

Name Data 

Protocol UDP 

Destination IP Address 127.0.0.1 

Destination Port Number 6100 

Local IP Address 127.0.0.1 

Local Port 0 

 

45. Your dialog should look similar to the one shown in Figure 52.  Push the OK 

button to add the service.   
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Figure 52 Generator Add Service Dialog Forward Tab 

 

46. Your Main Window should look like the one shown in Figure 53. 
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Figure 53 Generator Main Window with Packet 314 

 

47. Now that you have identified the telemetry packet to send, you can activate the 

service. In the Generator main window select the Packet 314 service, go to the 

Service menu and select Activate Service.  The service in the Generator will turn 

blue to indicate it is active and ready to generate data as shown in Figure 54.   
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Figure 54 Generator Main Window Activated Service 

 

 

48. Now that you have activated the service you can start the data flow.  In the 

Generator main window select the Packet 314 service, go to the Service menu and 

select Start Packets.  The service in the Generator will turn green to indicate it is 

generating Packet 314 as shown in Figure 55.   
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Figure 55 Generator Sending Packet 314 

 

 

49. Look at the TReK Data Main Window.  The service named Packet 314 is green 

indicating it is receiving data as shown in Figure 56. 

 



5.4.0 ISS TREK-USER-0024 

 45 

 

Figure 56 TReK Data Receiving Packet 314 Data 

 

 

50. Look at the TrekCcsds.314 display.  The Value column should contain data 

values as shown in Figure 57.  The data value of each parameter in the packet is 

displayed on the TrekCcsds.314 display each time a new packet of data arrives 

and is processed by the TReK Data application.  The Status column will be empty 

until there is status information to display. 

 

 



5.4.0 ISS TREK-USER-0024 

 46 

 
 

Figure 57 TrekCcsds.314 Packet Data Values 

 

 

Congratulations – you have successfully completed the Tutorial! 

 


